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Chapter 1 Introduction 

Welcome to Moxa EDS-SNMP OPC Server Pro, which can be integrated seamlessly with the 
leading HMI/SCADA software to create a comprehensive Ethernet Network Management Solution 
for all SNMP compatible devices. Moxa EDS-SNMP OPC Server Pro, which supports OPC Data 
Access 2.0 and ranks as a new generation of industrial software applications, was implemented 
using advanced programming concepts from the latest OPC specifications. 

OPC
Client

OPCOPC

HMI/SCADA,
InTouch, iFix

SNMP
OPC

Server

SNMP
OPC

Server

EDS-726

EDS-508

ED6008

NPort

3    Party
SNMP

Open Architecture

SNMP MIB

SNMP MIB

SNMP M
IB

SNMP MIB

SNMP MIB

rd

 
 

The following topics are covered in this chapter: 

 

 Features 
 Package Checklist 
 System Requirements 

 Minimum Hardware Requirements 
 Minimum Software Requirements 
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Features 
 Easy to Network Search for ED6008/EDS-508/EDS-726, and any SNMP compatible device 
 Easy to create and edit the configurations of connected devices in advance 
 Easy to create and edit the MIB Template for a dedicated tag file of any SNMP compatible 

device 
 User-definable tag file meets the requirements of many different applications 
 Ensure correct configuration with on-line monitoring ability 
 Test in advance with the simple test client test program that is bundled with OPC Pro 

NOTE In this manual, we often use “OPC Pro” in place of “EDS-SNMP OPC Server Pro.” 

Package Checklist 
OPC Pro is shipped with the following items: 

 CD Cover 
 Software CD 
 Quick Installation Guide 

If any of these items is missing or damaged, please contact your customer service representative 
for assistance. 

System Requirements 

Minimum Hardware Requirements 
 Memory: at least 128 MB 
 Computer/Processor: 266 MHz or higher Pentium-compatible CPU 
 Disk space: 20 MB for basic installation and system usage. 

Minimum Software Requirements 
 Operating System: NT ̀4.0 SP4, Windows XP (32 bit), Windows 2000 (Professional or Server 

version), Windows 2008 Server (32/64 bit), Windows 7  (32/64 bit)
 Supported Products: Moxa EDS managed series switches, such as ED6008, EDS-508, 

EDS-726, and other SNMP compatible devices 
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Chapter 2 How to use EDS-SNMP OPC Server Pro 

This chapter describes how to install and use Moxa EDS-SNMP OPC Server Pro. Refer to the 
“Operation Flowchart” section for a good overview of how to use OPC Pro with Moxa EDS 

owchart 

switches or any other SNMP compatible device. Read this chapter thoroughly to gain a full 
understanding of Moxa EDS-SNMP OPC Server Pro’s management functions. 

The following topics are covered in this chapter: 

 Installation 
 Starting EDS-SNMP OPC Server Pro 
 Operation Fl
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Installing the Software 
Follow the instructions given here to install the OPC Pro software. 

1. Insert the Moxa EDS-SNMP OPC Server Pro CD into your computer’s CD drive and wait for 
the installation program to start running. If the installation program does not start running 
automatically, run the setup program by double clicking on the setup.exe icon. 

2. When the Setup window opens, Click on Next to start the Setup Wizard. 

 
3. Read through the license agreement, select I accept the agreement, and then click on Next. 
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4. The setup program will select a default folder for program files. Modify as needed, and then 
click on Next to continue. 

 
5. Verify that the folder is correct, and then click on Install to continue. 
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6. Wait while the software is installed. 

 
7. Click on Finish to exit the setup program. 
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Starting EDS-SNMP OPC Server Pro 
1. To start using EDS-SNMP OPC Server Pro, click on Start  Programs  Moxa 

EDS-SNMP OPC Server Pro  OPC Server Pro. 

 
2. If this is the first time you’ve used this copy of the software, a Registration Code window will 

open as shown below. Enter the Registration Code shown on the CD’s sticker and then 
click on OK. Note that the registration code is case sensitive. 

 
3. If you enter an incorrect Registration Code, an error message will appear.  

 
4. Click on OK to stop the program. You will need to start over from step 1 above. 
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5. After entering the correct Registration Code, the Moxa EDS-SNMP OPC Server Pro will 
open. 

 

Operation Flowchart 
EDS-SNMP OPC Server Pro provides a user-editable Tag file for any SNMP compatible device. 
Use the default MIB file, or create and edit a standard or private MIB to generate a dedicated Tag 
file. This powerful function lets operators use an existing HMI software environment to create a 
customized, real time view of the integrity of any Ethernet network device, the overall Ethernet 
network traffic volume, and overall Ethernet network status. 

The following operation flowchart gives you a good overview of how to use OPC Pro with Moxa 
EDS series products and any SNMP compatible device. Refer to the sections from Chapter 3 for 
detailed information about using each function. 
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MIB Compiler 
Generate an OPC Pro 
MIB module from 
any SNMP compatile 
devices’ MIB file. 
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Define a specific 
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its OPC Pro MIB 
module and OIDs. 

Dedicated IP 
Designate Device 
Name, Description, 
and Device Type 
related factors for 
connected EDS units 
or SNMP compatile 
devices in advance. 

Add New Tag 
Designate specific 
monitored tags for 
connected EDS units 
or SNMP compatile 
devices. 

Add New Group 
Designate specific tag 
group name for 
connected EDS or 
SNMP compatile 
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Communicate 
with Moxa EDS 
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Network Search 
for EDS or SNMP
compatible devices

Yes
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No
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Ready to 
Montor
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Chapter 3 Featured Functions 

In this chapter, we give detailed information about using each of EDS-SNMP OPC Server Pro’s 
functions. 

The following topics are covered in this chapter: 

 MIB Compiler 
 Device Type Define 
 Network Search 
 Dedicated IP 
 Add New Group 
 Add New TAG 
 Monitor 
 New Configuration 
 Import Configuration 
 Export Configuration 
 Exit 
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MIB Compiler 
This function generates a specific MIB module for an SNMP compatible device. Click on MIB 

Compiler under the Tool menu bar item, or click on the toolbar MIB Compiler icon . You 
may also type the shortcut <Alt>-<T> to activate the MIB Compiler function. 

 
Use MIB compiler to generate a customize MIB module for OPC Pro. The OPC Pro MIB module 
can generate three kinds of MIB file format. 

Compiler MIB File: 
1. Select Compiler MIB File to generate a specific OPC Pro MIB module from a MIB file 

(standard MIB text file format). 
2. Browse the MIB text file (*.my, *.mib, *.txt) that is to be transferred. 
3. Click on Open to generate the OPC Pro MIB Module. 
4. The MIB will be compiled automatically into the OPC Pro MIB Module. 

 
Compiler Excel (CSV) File: 
1. Select Compiler Excel (CSV) File to generate a specific OPC Pro MIB module from an 

Excel (CSV) File. 
2. Browse the MIB Excel (CSV) file that is to be transferred. 
3. Click on Open to generate the OPC Pro MIB Module. 
4. The MIB will be compiled automatically into the OPC Pro MIB Module. 
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Compiler Excel (TAB) File: 
1. Select Compiler Excel (TAB) File to generate a specific OPC Pro MIB module from a 

Compiler Excel (TAB) file. 
2. Browse the MIB Excel (TAB) file that is to be transferred. 
3. Click on Open to generate the OPC Pro MIB Module. 
4. The MIB will be compiled automatically into OPC Pro MIB Module. 

The Excel file below is an example of a file that is to be transferred to an OPC Pro MIB module. 

Setting Description Criteria 
First row Name of each parameter. The first and second rows will 

not be transferred into an OPC Pro MIB module. 
None 

Object ID SNMP TAG Object ID Max. 80 bytes 
Tag Name SNMP TAG Name Max 80 bytes 
Read/Write SNMP access right. Must be ‘read-only” or 

“read-write”—any other string will cause a compile error 
read-only, 
read-write 

Data Type Date type defined for SNMP Tag. Must be “String,” 
“Integer,” “Counter,” “Gauge,” “TimeTicks,” or 
“IpAddress.” Any other string will cause a compile error. 

String, Integer, 
Counter, Gauge, 
TimeTicks, 
IpAddress 

Defined 
Value 

Defined value for SNMP Tag Max. of 500 bytes 

Description Descriptive value for the SNMP Tag Max. of 500 bytes 
 

1. Start Excel and then build the table described above. 

2. Save the file using format CSV or TAB. 

 The CSV file format uses a comma ( , ) to separate columns. So, do not use commas in 
this Excel file. 

 The TAB file format uses the Tab keystroke to separate columns. So, do not use “tab” in 
this Excel file. 
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The MIB Compiler window is shown above. The MIB Module Name is shown in the top-left part 
of the window. The Tree View shows all MIB Identifier Names and corresponding ObjectID. The 
top-right Compiler Message section is reserved for error statements. Detailed information is 
shown in the bottom half of the window. Items displayed in the bottom half of the window are 
described below: 

Item Description Criteria 
MIB II parameter name SNMP MIB Name Max 1000 
ObjectID SNMP Object ID Max 256 ID 
Read/Write read-only, read-write, read-create, and 

not-accessible 
4 options 

Data Type String, Integer, Counter, Gauge, 
TimeTicks, and IpAddress 

6 options; 
Max. of 100 new data types

Index Sequence Index; 
0 means no index, number means 
index level 

Max. of 10 index levels; 
Max. of 100 sequence 
index TAGs 

Parameter Definition SNMP TAG Parameter Definition No limit 
Description SNMP TAG Description No limit 
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Device Type Define 
The Device Type Define page makes it easier to insert specific MIB files into any SNMP 
compatible device. Click on Device Type Define under the Tool menu bar item, or click on the 

toolbar Device Type Define icon . You may also type the shortcut <Alt>-<T> to activate the 
Device Type Define function. 

 
 

Setting Description 
Device Type Name Define the type name for SNMP compatible device 

Max. of 256 bytes 
sysObjectID checking string Customer-defined string used to verify the device type while 

running a network search. 
User defined check string 
(checkbox) 

Enable/disable user define ObjectID string to verify the device 
type while running a network search. 

User defined ObjectID Designate a specific ObjectID to get the string for device type 
verification while running a network search. 
Max. of 128 bytes 
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New Add a new device 
Rename Rename a device 
Copy Copies selected device 

These options will appear in 
the pop-up menu when right 
clicking in the lower left 
section of the “Device Type 
Define” window. Delete Delete a device 
Insert MIB Module Uni/multi select MIB module and insert into specific device type
Delete MIB Module Uni/multi select MIB module from specific device type 
File Name MIB module file name 
Modified Date/Time date/time the MIB module was last modified 
Created Date/Time date/time the MIB module file was created 

Network Search 
The Network Search function is used to search for Moxa EDS and other SNMP compatible 
devices on the current LAN. Click on Network Search under the Add menu bar item, or click on 

the toolbar Network Search icon . You may also type the shortcut <Alt>-<A> to activate the 
Network Search function. 

 
After searching automatically for devices on the LAN, the Broadcast Network Devices window 
shown below will open. Moxa EDS or SNMP compatible devices that are currently online will be 
listed in the window. 
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Network Search 

Setting Description Factory Default 
Start IP Address Network Search will start searching with 

this IP address 
192.168.127.1 

End IP Address  Network Search will stop searching with this 
IP address 

192.168.127.1 

Port Remote SNMP compatible device UDP Port 
No. 

161 (ranges from 1 to 10000) 

SNMP Version Select an SNMP version of V1, V2c, or V3 
for network search 

V1 

Community String of SNMP V1 and V2c for network 
search 

public 
Max. of 30 Characters 
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Example 1: Start IP Address: 192.168.127.2 
End IP Address: 192.168.127.253  
Network Search will search a total of 252 IP addresses. 

Example 2: Start IP Address: 192.168.125.2 
End IP Address: 192.168.127.5 
192.168.125.2 to 192.168.125.254: 253 IP addresses. 
192.168.126.1 to 192.168.126.254: 254 IP addresses 
192.168.127.1 to 192.168.127.5: 5 IP addresses 

 Network Search will search a total of 512 = 253+254+5 IP addresses. 

NOTE A buffer that holds a maximum of 512 IP addresses is reserved for each network search. 

SNMP V3 
Setting Descriptions Factory Default 

User Name  User name for network search of SNMP V3 “user” if select SNMP V3 for 
network search  
Min. of 8 characters 
Max. of 16 characters 

Password  Password for network search of SNMP V3 Empty if select SNMP V3 for 
network search  
Min. of 8 characters 
Max. of 16 characters 

Auth. Type Provides authentication based on the 
No-Auth, MD5, SHA 

No-Auh if select SNMP V3 for 
network search 

Data Encryption 
Type (Privacy 
Protocol) 

Provides data encryption type based on 
None, CBC-DES and CFB-AES-128 None if select SNMP V3 for 

network search 

Data Encryption 
Key 

String for designated data encryption None if enable CBC-DES or 
CFB-AES-128  
Min. 8 characters 
Max. 30 Characters 

Context Name Context Name for SNMP V3 None 
Max. 16 Characters 

Context Engine 
ID 

Context Engine ID for SNMP V3 None 
Max. 30 Characters 

Timeout 
(msec) 

Time out period for each network search. 1500 
ranges from 1000 to 10000 ms

Search Press “Search” button to begin Network 
Search None 

Stop Press “Stop” button to stop Network Search None 
Searching Display current IP address searching None 
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Searched Devices 
 All searched devices will list in this table 
 Double click the mouse to enter Device Type Define page to designate a device type or for 

details related to parameter settings 

Setting Description Factory Default 
Asterisk An asterisk is used to mark devices that have 

a defined device type. 
None 

IP Address  IP Address of searched device None 
Device Type Device type of searched device Moxa EDS managed switch 
Description Description of searched device Moxa EDS managed switch 

Defined Devices 
 Lists searched devices with Device Type Defined 
 Double click the left mouse button to enter the Device Type Define page to edit related 

parameter settings 

Setting Description Factory Default 
IP Address IP Address for searched device None 
Device Name Each searched device with dedicated device 

name 
None 

Device Type Device type for searched device Moxa EDS managed switch 

Dedicated IP 
Use a dedicated IP address, to ease network planning, by configuring the connected Moxa EDS or 
SNMP compatible device in advance. Click on Dedicated IP under the Tool menu bar item, or 

click on the toolbar Dedicated IP icon . You may also type the shortcut <Alt>-<T> to activate 
the Dedicated IP. 
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Setting Descriptions Factory Default 
Device name Each defined EDS or SNMP compatible 

device has its own name. 
DeviceX, 
Max 80 characters 

Description Description of defined EDS or SNMP 
compatible device 

Max 256 characters 

Device Type Select suitable device type for defined EDS 
or SNMP compatible device 

Unknown 

IP Address IP Address Device type for defined EDS or 
SNMP compatible device 

192.168.127.253 

SNMP Port No. Remote SNMP compatible device UDP Port 
No. for defined EDS or SNMP compatible 
device. 

161 
Ranges from 1 to 10000 

SNMP 
Version 

Select SNMP version of V1, V2c or V3 for 
defined EDS or SNMP compatible device 

V2c 

Community String of SNMP V1 and V2c for defined 
EDS or SNMP compatible device 

public 
Max. of 30 characters 

 

NOTE Click a heading on the tool bar (IP Address, Device Type, or Device Name) to sort the list in an 
increasing or decreasing sequence using the items in that column. 

 
SNMP V3 
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Setting Description Factory Default 
Current User Select user account for current 

communicating account of defined EDS or 
SNMP compatible device 

None 
Admin and user if select Moxa 
EDS as device type 
Max. of 10 accounts; each 
account length from 8 to 16 
characters. 

User Name  Display current communicating account for 
defined EDS or SNMP compatible device 

None 
Min. of 8 characters 
Max. of 16 characters 

Password  Display current password for defined EDS 
or SNMP compatible device 

None 
Min. of 8 characters 
Max. of 16 characters 

Auth. Type Display current authentication algorithm for 
defined EDS or SNMP compatible device 

No-Auth if select SNMP V3 for 
network search No-Auth, MD5 
andSHA 

Data Encryption 
Type (Privacy 
Protocol) 

Display current data encryption type for 
defined EDS or SNMP compatible device 

None if select SNMP V3 for 
network search  
None, CBC-DES and 
CFB-AES-128 

Data Encryption 
Key 

Display string for data encryption for 
defined EDS or SNMP compatible device 

None if enable CBC-DES or 
CFB-AES-128  
Min. of 8 characters 
Max. of 30 Characters 

Context Name Display current context name for defined 
EDS or SNMP compatible device 

None 
Max. of 16 Characters 

Context Engine 
ID 

Display current context engine ID for 
defined EDS or SNMP compatible device 

None 
Max. of 30 Characters 

Add User Press Add User button to add SNMP V3 
communicating account 

Admin and user if select Moxa 
EDS as device type 
Max. of 10 accounts 

Edit User Select which current account needs to be 
edited and press Add User button to edit the 
current SNMP V3 communicating account 

Admin and user if select Moxa 
EDS as device type 
Max. of 10 accounts 

Delete User Select which current account needs to be 
deleted and press Delete User button 

None 

Change 
password 

Type old password, New password, and 
retype password 

Min. of 8 characters 
Max. of 16 characters 
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Setting Descriptions Factory Default 

Timeout 
(m sec) 

Amount of time allowed to complete an 
SNMP get. In situations where there might 
be a lot of traffic on the network, a longer 
timeout setting might be helpful. 

1500 
ranges from 1000 to 10000 ms

Retry Count After an attempt to get data has timed out, 
the retry count value is the number of times 
the SNMP manager will attempt to retrieve 
the data before failing. 

2 
ranges from 1 to 10 

Skip Count  The time that the manager will wait before 
attempting another GET from a device that 
has failed. The time unit is defined in the 
Device timeout setting. Skip count is an 
efficient way to reduce network traffic. 
(E.g., 1500 ms device timeout with 80 skip 
count =12000 ms before new attempt) 

80 
ranges from 10 to 500 
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Add New Group  
Add a new tag group for a dedicated device. Click on New Group under the Add menu bar item, 

click on the toolbar New Group icon , or move the courser to a dedicated device and click the 
right mouse button and select New Group. You may also type the shortcut <Alt>-<A> to activate 
the New Group function. 

 

 
 
Select Rename to edit, and then click on OK to activate the setting. 
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Add New TAG 
Create OPC TAGs for a dedicated device or group. Click on New TAG under the Add menu bar 

item, click on the toolbar New TAG icon , or click the right mouse button and select New Tag. 
You may also type the shortcut <Alt>-<A> to activate the New Tag function. 

OPC TAG Edit 
Setting Description 

Insert TAG Uni/multi select and insert OPC TAGs for dedicated device 
Delete TAG Uni/multi select and delete OPC TAGs for dedicated device 
ok Activate the setting 
cancel Ignore the setting 
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Insert the OPC TAG with sequence index, and then enter proper number in the index box. 

 

Decimal/Hex transfer
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Tag Properties 
Move the cursor over any MIB II parameter in the right side of the window and click the right 
mouse button. 

 
Or, select Properties under the Configuration menu. 

 
You will see the detailed tag properties. E.g., MIB II parameter name, Monitoring value of return, 
Parameter Definition, and Description. 
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NOTE MIB II Parameter Name: the mapping OPC TAG name 
Parameter Definition: MIB II Parameter type 
Description: Describes how this parameter works  
Object ID: SNMP TAG Object ID 
Data Type: Converted from SNMP TAG Data type within OPC Data Type v2.0 
Number of Bytes: Length of OPC TAG, consistent with SNMP 

 

TIPS 
Changing Items in the Tree Browser 
After modifying devices, groups, or tags in the OPC Server Tool, changes will take effect 
immediately on the I/O Server and will be displayed automatically in the Tree Browser. 

Collapsing and Expanding the Tree Browser 
You can collapse or expand the tree by double-clicking. 

Navigating in the Tree Browser 
You may use the mouse or keyboard to navigate through the Tree Browser, in the left side of the 
window. Use the up or left arrow keys to move up, and use the down or right arrow keys to move 
down in the Tree Browser. You can also press a letter key to jump to the nearest item that begins 
with that letter. 

Additional Tree Browser Features 
Connection lines show the relationship between devices, groups, and tags by displaying which 
devices are on a channel and which tags belong to a device. The plus and minus buttons indicate 
whether items are fully expanded or collapsed. The plus button shows the item is collapsed and the 
minus button indicates that the item is expanded. For example, a device with a plus sign next to it 
means that there are groups and possibly tags configured on that device. 

Copy, Paste, Delete, Rename 

 

?_means without Device Type 
defined, e.g., unknown type 

 
TAG number in 
current group 

Copy source Group or TAG  
 
Copy 
Click the right mouse button to copy Device, Group, and TAG 

Paste 
Click the right mouse button to paste Device, Group, and TAG 
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Delete 
Click the right mouse button to delete Device, Group and TAG 

Rename 
Click the right mouse button to rename Device, Group and TAG 

 

TAG Definition 
SNMP Data Type / OPC TAG Data Type Table 

SNMP Data Type OPC TAG Data Type 
String Max String 128 bytes 
Integer 32 bits, Integer 
Counter 32 bits, unsigned integer 
Gauge 32 bits, unsigned integer 
IP Address Max String 16 bytes 
TimeTicks 32 bits, unsigned integer 
ObjectID Max String 128 bytes 

Monitor 
This section describes how to monitor all communication between EDS-SNMP OPC Server Pro 
and devices. Click on Monitor under the View menu bar item, or click on the toolbar Monitor icon 

. You may also type the shortcut <Alt>-<V> to activate the Monitor function. 

 
After updating, the following window will appear. 

 
 

When you use the monitor function, you can see the data returned by the device that is connected 
to EDS through Moxa EDS-SNMP OPC Server Pro. There are four kinds of information shown in 
the right pane of the window. If the communication fails, the message Bad will be shown in 
Monitoring value of return. Otherwise, you will see the numbers that were returned, as shown 
above. 
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NOTE The Status Bar is used for disabling or enabling the status bar on the bottom of the screen. The 
Help Menu shows the Moxa EDS-SNMP OPC Server Pro version, copyright, and related 
information. 

 
OPC Stat 

The log file for OPC Pro 

 
 

New Configuration 
When you start OPC Server, you can create a new configuration file by clicking on the File menu 
bar item, and then selecting New. 

 
A system window will open as shown below. You can now start a new configuration. 
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NOTE The latest configuration will be imported. automatically when you start OPC Pro. 

 

Import Configuration 
When you want to modify an existing configuration with TDB file type, select Open under the 
File menu bar, and then select Open to begin. 

 
A window will open. Select the desired configuration file and click Open. 
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The following window indicates that the configuration was imported successfully. 

 

Export Configuration 
After creating a new configuration or modifying an existing configuration, you need to export 
revised files by selecting Save or Save As under the File menu. 

 
When the following window opens, enter a configuration file name, and click Save.  

 

Exit 
To quit the program, select Exit under the File menu. 
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Chapter 4 How to use Test Client 

This chapter describes Test Client, provided by the Moxa EDS-SNMP OPC Server Pro, with a 
quick connection to OPC Server. The Test Client is able to browse the registered OPC Servers in 
the same server hardware. It also provides real live data feedback and OPC Server browsing 
capabilities. 

The Test Client is also helpful for connecting and testing other 3rd party OPC applications located 
on the same server hardware. 

The following topics are covered in this chapter: 

 Starting Test Client 
 Connection 
 Modifying the Configuration 
 Exit 
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Starting Test Client 
To start Test Client, click on Start  Program  Moxa EDS-SNMP OPC Server Pro  Test 
Client. 

 
Start Test client to check the connection. 
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Connection 
To connect Test Client to Moxa EDS-SNMP OPC Server Pro, select Connect under the OPC 

menu, or click on , the Connect toolbar icon. 

 
A window listing all OPC Servers located on the same server hardware will open. E.g., 
Moxa.SNMPOPC. 

 
 

NOTE When your Test client connects to Moxa EDS-SNMP OPC Server Pro, it will execute 
automatically. You may disconnect the selected server by selecting Disconnect from the menu. 
This command will un-register the device interface, and release the Group object and Server 
object. Releasing an object means that the client has nothing to do with the object, and the object 
can be deleted from the server by the system. 
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Modifying the Configuration 

Server Status 
To see the status of the Server, select Server Status under the OPC menu. 

 
The Server Status window looks like this:  

 
 

NOTE Start Time: the time the server starts running 
Last Time:  the last update time from the server  
Current Time: the current time from the server 
The Server Status window queries the Server object periodically for the status, and displays the 
results. When the OPC TAG is updated, the OPC Server will advise the connected clients, so that 
‘Last’ in client shows the updated time. 

 

 

 

 

 

 

 

 

 

www.ipc2u.ru www.moxa.pro



Moxa EDS-SNMP OPC Server Pro User’s Manual How to use Test Client 
 

 4-5

Update rate 
To modify the update rate, select Update rate under the OPC menu. 

 
Modify the Update Rate as needed, and then click on OK. 

To be able to read the item, set the Update Rate to a number. 

 
 

NOTE Active: active state for OPCGroups 
Update Rate: the update rate (in millisecond) for OPCGroups is 10 ms minimum. 

Default value is 100 ms. This is the time interval that Test client uses to access OPC 
Server. 

The Group Parameters window queries the group state and displays the results. When you click 
the OK button in this window, the system will write the parameters from the window to the 
Group object and send the parameters back. This function helps to control scanning and updating 
of data. The Update Rate in the Group Parameters dialog box specifies the rate at which data 
notifications should be sent back to the client if the data has been changed. This is also the rate by 
which items are scanned in this client. Once a group is inactive, it will not send data notifications 
to the client and scan items. 
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Add Item 

Select Add Item under the OPC menu or click on the Add Item toolbar icon . 

 
Test Client will open the Add Item window. Expand the list in the left window, and click any 
group name, such as Configuration, Traffic, or System. Select the tags shown in the right pane that 
you wish to monitor, and then click OK. 

 
You will now be able to see the connection and monitor the return value from OPC Server. 
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Read Item 
To see the OPC Server TAG value, select Read Item under the OPC menu, or click on the Read 

Item toolbar icon . It is recommended that you perform this function after modifying a longer 
Update Rate. 

 

Delete Item 
To delete the TAG you are monitoring, select Delete Item under the OPC menu, or click on the 

Delete Item icon . 

 

 
 

Write Value to Item 
To write value to the Tag, select Write Value to Item under the OPC menu. 
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Exit 
To exit the program, select Exit under the OPC menu. 
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Chapter 5 How to use File Conversion 

This chapter describes EDS-SNMP OPC Server File Conversion, provided by the Moxa 
EDS-SNMP OPC Server Pro, with this file conversion that will ease your file migration from 
current EDS-SNMP OPC Server to EDS-SNMP OPC Server Pro. 

The following topics are covered in this chapter: 

 Starting EDS-SNMP OPC Server File Conversion 
 Clear Configuration 
 Open Old Version 
 Save New Version 
 Exit 
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Starting EDS-SNMP OPC Server File Conversion 
When upgrading from EDS-SNMP OPC Server to EDS-SNMP OPC Server Pro, you must 
uninstall EDS-SNMP OPC Server first. Before uninstalling EDS-SNMP OPC Server, remember to 
save the old configuration file (.tdb). You will use the EDS-SNMP OPC Server File Conversion to 
convert the old OPC file to an OPC Pro file. EDS-SNMP OPC Server Pro supports several new 
functions, such as SNMP V2C/V3 read/write, MIB compile, and Tag editable, which are different 
from EDS-SNMP OPC Server. That’s why the file name of the old OPC file and OPC Pro file are 
the same, but the formats are different. You cannot use EDS-SNMP OPC Server to open 
EDS-SNMP OPC Server Pro the configuration file (.tdb), and vice verse. 

 

Clear Configuration 
To clear the current configuration, select Clear configuration under the File menu. 

 

Open Old Version 
To open a configuration for the old version, EDS-SNMP OPC Server, select Open old version 
under the File menu. 

 

 

 5-2

www.ipc2u.ru www.moxa.pro



Moxa EDS-SNMP OPC Server Pro User’s Manual How to use File Conversion 

 

Save New Version 
To save a configuration of a new version, EDS-SNMP OPC Server Pro, select Save new version 
under the File menu. 

 

 

Exit 
To exit the program, select Exit under the File menu. 
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Appendix  A  EA rror Message Table  Appendix

1. Message Box: 

Message Description 
Error: End IP Address is less than Start IP 
Address 

An error occurred while Broadcast Search was 
searching for all of the IP Addresses in the range 
that was entered 

Invalid IP Address !!! IP Address has the wrong format 
Search device number: [xxx] is over 255 Broadcast Search cannot search more than 256 

IP Addresses 
[File Name]: read file error…. Unable to read a file 
[File Name]: open file error…. Unable to open a file 
[File Name] does not exist…. The file cannot be found 
[File Name]: get file time error…. The imported date/time was incorrect for some 

files 
[File Name]: already exists…. File with that name already exists 
[File Name]: create file error…. File could not be created 
[File Name] is not MIB table type….. The file is not a MIB Module File 
[File Name] is not Device Type file….. The file is not a Device Type File 
[File Name] does not exist; change device 
type to unknown type 

When entering OPC Device Define, if on 
inspection the Device Type File does not exist, it 
is stored as unknown type 

Select a device type first In Device Type Define, deleting, changing the 
name, etc., you must first select the Device Type 
Define File 

Delete device type: [Device Type File name] Will warn the user before deleting the file. 
Select a device type or insert a new device 
type first 

In Device Type Define, enter a new MIB 
Module first 

Old Password Error….. The old password that was entered is incorrect 
New Password Error….. The new password that was entered is incorrect 
The length of New Password is less than 8 
char. 

The new password must be at least 8 characters

The length of Read Encryption key is less 
than 8 char. 

The Read Encryption key must be at least 8 char

The length of Write Encryption key is less 
than 8 char. 

The Write Encryption key must be at least 8 char
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Message Description 
The length of file name is over 256 File Name cannot exceed 256 bytes 
Index-1 is over range [%d to %d] When adding Sequence Index TAG, the Index 

was out of range 
This Tag is not a read-write type !!! Tag is not read-write type, and cannot be 

changed to read-write type. 
Tag: [xxx] is a “not-accessible” type When adding an OPC Tag, if the Tag Data Type 

in the MIB Module File is “not-accessible,” then 
the tag cannot be added. 

Duplicated device names are not permitted OPC device names cannot be duplicated 
Duplicated group name is not permitted OPC group names cannot be duplicated 
Device: [xxx] Already Exists The OPC Device name already exists 
Group: [xxx] Already Exist! The OPC Group name already exists 
Tag: [xxx] Already Exist! The OPC Tag name already exists 
Device’s Name does not accept Dots! The “dot” character cannot be used as part of an 

OPC device name 
Group’s Name does not accept Dots! The “dot” character cannot be used as part of an 

OPC group name 
Tag Name does not Accept Dots! The “dot” character cannot be used as part of an 

OPC Tag name 
Cannot change files while OPC Clients are 
connected to this server. 

You cannot change to a different Configure File 
while connected to an OPC Client. Doing so will 
cause the OPC to become disconnected from the 
TAG. 

The Device type is unknown type, please set 
a device type first… 

If the Device Type is an unknown type, you will 
not be able to open the OPC TAG Edit window 
(from the [New TAG] menu). 

Can’t paste the same group…. When pasting an OPC Group, you cannot paste 
over an existing group, since doing so would 
allow the system to create an unlimited number 
of groups. 

Ole Initialization failed When OPC is unable to start the OLE 
configuration procedure, you can assume that 
Windows has encountered an unrecoverable 
problem. At this point, it is advisable to reinstall 
the OS. 

Failed Register!!! System error code: xxx= 
REG_E_CLASSNOTREG 
Please contact support@moxanet.com 

OPC is unable to register with the OS 
automatically. This problem usually occurs with 
Windows NT. A detailed explanation follows. 

Create SNMPOPC Register Key error Unable to establish an OPC software serial 
number Key in the Windows Register. You can 
assume that Windows has encountered an 
unrecoverable problem. At this point, it is 
advisable to reinstall the OS. 

Set SNMPOPC Register key error Unable to establish an OPC software serial 
number Key in the Windows Register. You can 
assume that Windows has encountered an 
unrecoverable problem. At this point, it is 
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Message Description 
advisable to reinstall the OS. 

Registration Code error !!!!! The user has entered an incorrect OPC software 
serial number. The program has terminated. 

  
 

2. MIB Compiler Error Messages 

Message Description 
MIB File  
Record=xxx IDENTIFIER: xxx is not found The Identifier Name being searched for cannot 

be found on line xxx of the MIB file. 
Record=xxx can’t find data type: xxx The Data Type definition being searched for 

cannot be found on line xxx of the MIB file. 
Record=xxx TAG[xxx] has syntax error… The last Tag that was tested on line xxx of the 

MIB file has a syntax error. 
Record=xxx TAG[xxx]: xxx is not found The TAG in line xxx of the MIB file accepted 

the previous definition, but the Identifier Name 
that was referred to. 

Record=xxx lost TEXTUAL_CONVENTION 
definition 

In line xxx of the MIB file, cannot find the 
definition of the last result 

Error: [End] string is not found……. Cannot find the END character in the MIB file
Error: MIB file has syntax error…… When the following error occurs, the last bit of 

data that shows up in the Compiler result will 
not be saved to the file. 

Excel File (CSV, TAB)  
Record=xxx, it is not 4 to 6 column parameters The field definition in line xxx in the Excel file 

must be 4 to 6 characters 
Record=xxx, The size of TAG name is over, it 
must be 1 – 80 bytes\ 

The TAG length in line xxx of the Excel file 
cannot exceed 80 bytes 

Record=xxx, The char. Of TAG Name can not 
include ‘.’ 

The TAG in line xxx of the Excel file cannot 
contain a dot 

Record=xxx, The size of Object ID is over, it 
must be 1 - %d bytes 

The length of the Object ID in line xxx of the 
Excel file cannot exceed 80 bytes 

Record=xxx, The char. Of Object ID must be 
‘0 – ‘9’ or ‘.’ 

The Object ID in line xxx of the Excel file can 
only contain alphanumeric characters or a dot.

Record=xxx, The R/W Flag must define as 
[read-only] or [read-write] 

Line xxx of the Excel file can only be 1 of 2 
types: read-only or read-write 

Record=xxx, The Data type must define as  
[Integer], [String], [IPAddress], [Counter],     
[Gauge], [TimeTicks], [ObejctID] 

The Data type of line xxx in the Excel file can 
only be [Integer], [String], [IPAddress], 
[Counter], [Gauge], [TimeTicks], [ObjectID], 
etc. 

Record=xxx, The size of defined value string 
is over, it must be 1 – 500 bytes 

The “define value” in line xxx of the Excel file 
cannot exceed 500 bytes. 

Record=xxx, The size of description string is 
over, it must be 1 – 500 bytes 

The description length in line xxx of the Excel 
file cannot exceed 500 bytes 
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3. OPC State shows a communication error 

Message Description 
Device: [xxx] V3 Auth. Security password 
error. 

Error computing Auth. Security 

Device: [xxx] V3 Privacy security password 
error 

Error computing Privacy Security 

Device: [xxx] snmp open error Open snmp session error 
Device: [xxx] TAG Type:0x81 error Received SNMP TAG response, but the Object 

ID probably does not exist 
Device: [xxx] Get command error Error sending Get command (Read TAG value) 
Device: [xxx] Get command timeout Get command was sent, but the reply is overdue
Device: [xxx] Set command error Error send Set command (Write TAG Value) 
Device: [xxx] Set command timeout Set command was sent, but the reply is overdue
Device: [%s] comm. suspension After 3 signal timeouts, the system will pause 
Device: [%s] comm. release, try again The system will attempt to transmit again after 

surpassing the pause time 
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